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1 Introduction 
StageShow is a Wordpress plugin designed to enable amateur theatre groups 
and small theatres to sell tickets online.  
 
Three versions are available as follows:  
 
StageShow  provides basic functionality and is primarily intended for use by 
theatre groups that put on one or two shows a year.  
 
StageShow+  extends the functionality of StageShow to add additional features 
for larger groups where the number of ticket sales is larger or shows are more 
frequent. 
 
StageShowGold  further extends the functionality of StageShow+ to add the 
facility for allocated Seating with customisable venue Seating Plans. 
 
This document describes the setup requirements and the features of 
StageShowGold. The setup requirements and features of StageShow+ and 
StageShow are a subset of these. Features marked as (from StageShow+) are 
available with StageShow+ and StageShowGold only. Features marked as (from 
StageShowGold  only) are available only available with StageShowGold.  
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2 Features Overview  
A StageShow plugin, combined with a PayPal account, provides everything 
needed to add an online box-office to a Wordpress web site for small to medium 
sized theatres. This document describes the features available in 
StageShowGold. Some of these features will either not be available, or will have 
limitations in StageShow and StageShow+. 

2.1 Versions 
Three versions are available: StageShow provides basic functionality and is 
intended for use by theatre groups that put on one or two shows a year. 
StageShow+ extends the functionality of StageShow to add additional features 
for larger groups where the number of ticket sales is larger or shows are more 
frequent. StageShowGold further extends the functionality of StageShow+ to 
support allocated seating. 

2.2 Shows 
The StageShow system administrator can define one or more Shows for which 
tickets are to be offered for sale using the StageShow-Shows page. In addition to 
the Show name, a “Note” can be defined here, which can be in text or HTML 
format, which will be output with the Show name on the Box Office output. Each 
show can also be individually Deactivated which “hides” it from the Box Office 
output. 

2.3 Performances 
For each Show defined by the StageShow system administrator a number of 
Performances can be defined. This setup includes the date and time, a unique 
reference and the number of tickets available. A “Note” can be defined here, 
which can be in text or HTML format, which will be output with the Performance 
entry on the Box Office output. Each Performance can also be individually 
Deactivated which “hides” it from the Box Office output. 

2.4 Seating Plans (StageShowGold only) 
The StageShow system administrator can create one or more Seating Plans to 
define the seats available for a venue, and the identification of each row and seat 
number within that seating plan. A prospective purchaser is shown the seat 
availability on the Box-Office page and chooses the seat(s) they require during 
the purchasing process. 

2.5 Prices 
For each Performance a number of ticket prices are defined, each with its’ unique 
price type reference. Prices Plans, a template of price values, can be also be 
defined using a StageShow+ admin page. One of these Price Plan entries can 
then be selected when adding a new performance, greatly reducing the time 
needed to set up a new show. 
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2.6 Box Office Output 
StageShow displays Box Office output on a Wordpress Page or Post in response 
to a Wordpress Shortcode (a text sequence enclosed by square brackets) 
defined by the plugin code. Shows are output in date order, and are not displayed 
once the performance “expires” or it (or the Show it is part of) is deactivated. 
Parameters can be applied to this shortcode to add extra facilities, for example to 
output a specific show or to limit the number of shows displayed. 

2.7 Sales Emails 
All sales are confirmed with an Email which can be customised to suit individual 
requirements. These are in either text only, or mixed HTML/Text format. Sample 
templates are included with the distribution. Optionally, an additional “Sales 
Summary” email with total sales can be sent to a designed email each time a new 
sale is recorded. 

2.8 Ticket Validation 
StageShow includes facilities to validate tickets. This can be performed either 
online, or an “Offline Validator”, which includes a snapshot of the sales database, 
can be downloaded, allowing offline ticket validation. StageShow+ add the facility 
to record online validations, and to display all previous validations when a ticket is 
validated . 

2.9 Sales Logging 
StageShow records all sales, which can then be viewed and edited if required. 
These sales records can be exported as text files, which can be imported other 
programs (for example to a spreadsheet), or as a file conforming to the OFX 
standard for further analysis. 
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3 Prerequisites 
To use StageShow the following system prerequisites are required: 

3.1 Website hosting with Wordpress Installed 
The target website must have Wordpress set-up and working. 
For correct operation of StageShow the “Timezone”, “Date Format” and “Time 
Format” entries on the Wordpress Settings-General admin page must be set to 
appropriate values. If these settings are incorrect, time or daylight saving 
discrepancies, or formatting errors can occur. 

3.2 PayPal Account 
A working PayPal account is required for StageShow to operate. A “Business” 
account is recommended. StageShow+ can operate without a PayPal account if it 
will only be used for “Reservations” (see section 15.2) 

3.3 Wordpress Plugins 
Either the StageShow or StageShow+ plugin must be downloaded, installed and 
activated. 
The “User Role Editor” plugin is also recommended for use with StageShow. 
If “Reservations” (see section 15.2) are to be enabled, a plugin that adds 
additional fields to the user profile may be required. 
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4 Installation 
4.1 First Time Installation 

• Download the StageShow or StageShow+ plugin archive 

• Open the Wordpress Dashboard for you site 

• Select the "Upload" option  

• Click "Add New" under the "Plugins" menu  

• Under "Install a plugin in .zip format" browse to the StageShow plugin 
archive file you downloaded 

• Click Install Now. 

• After it has installed, activate the plugin. 
 

4.2 Upgrade 
• On the WP Plugins Page deactivate StageShow 

• Using FTP (or your ISPs file manager) delete the StageShow plugins 
folder in wp-content/plugins folder 

• Now Proceed as for the First Time Installation 
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5 PayPal Setup 
5.1 PayPal Settings 
This section details settings which must be set-up on the PayPal account which 
will be used to collect payments for StageShow. 

5.1.1 Merchant ID 
The Merchant ID setting identifies the PayPal account to be used to collect 
payments. 

5.1.2 API Access 
The API Access settings allow access to the PayPal account from another 
website server. These settings can created by selecting the Profile | My Selling 
Preferences | API Access menu on the PayPal account admin pages and 
choosing the “View API Signature” option. The API username, API password and 
Signature generated should be copied to the corresponding StageShow settings.  

5.1.3 IPN Setting 
The Instant Payment Notifications (IPN) settings control how PayPal sends 
information on sales to your website. These settings can modified via the Profile | 
My Selling Preferences | Instant payment notifications menu. The Receive IPN 
messages option should be selected and the Notification URL should be set as 
follows: 

{Your-site}/wp-content/plugins/{pluginName}/StageShow_ipn_callback.php 
Where: 

{Your-site} is the root URL of your Wordpress website 
{pluginName} is stageshow or stageshowplus as appropriate 

5.1.4 PayPal Account Optional 
If you want your purchasers to be able to use a credit or debit card without the 
requirement to have or create a PayPal account, then the “PayPal Account 
Optional” setting for your PayPal account must be set. This settings can modified 
via the Profile | My Selling Preferences | Website Preferences menu page. The 
setting should be set to “On” to make a PayPal account optional. 

5.1.5 Purchasers Phone Number 
If you want force or allow your purchasers to enter their contact telephone 
number, then the “Contact Phone Number” option must be set appropriately on 
the PayPal account. This setting can modified via the Profile | My Selling 
Preferences | Website Preferences menu page. The setting should be set to “On” 
to make PayPal capture phone number during the sale checkout process. 
StageShow will always record the phone number when it is requested by PayPal. 
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6 Show and Performances Setup 
This section details how to add your show, performance, ticket and price details 
to your StageShow configuration. In general these admin screens will be used in 
the order they appear in the StageShow menu (and the order in this document). 

6.1 Seating Plans Admin Page (StageShowGold only) 

6.1.1 Seating Plans  
StageShow can use Seating Plans, created by the System Administrator, to 
define the layout of seating for a performance, and the naming/numbering of 
those seats. Each Seating Plan defines an entire seating area in a venue, (for 
example including areas which are located on different floors etc.). Each Seating 
Plan includes a “Seating Plan Ref” by which it is referenced elsewhere in the 
admin pages, and one or more Seating Zones (see 6.1.2). 

6.1.2 Seating Zones 
Each Seating Plan includes one of more Seating Zones, defined by a Zone 
Specification (see 6.1.3), and identified by a unique “Zone Ref”. These Seating 
Zones define areas of seats which have the same ticket types and range of ticket 
prices. 

6.1.3 Zone Specification 
The Zone Specification defines what seats are available in a particular Seating 
Zone, and their layout when using the StageShow generated template. Each 
Zone Specification assumes that seats are laid out on a rectangular grid, with the 
position of each seat defined by a numerical row number and seat number within 
that row. For each position a seat may, or may not, actually be present. The 
System Administrator creates a Seating Plan Definition by creating a list of which 
seats within the grid exist, and StageShow creates an HTML template to display 
the seating layout and adds the template to the wordpress database. For layouts 
that cannot be represented by a rectangular grid, StageShow provides the facility 
to “Import” a custom layout template (see 6.1.5), which is then used to generate 
the box office output. 

6.1.4 Zone Specification Syntax 
The Zone Specification consists of one of more Seat Range Specifications 
separated by a comma. Zone Specifications may specify a block of seats, or a 
single seat as follows: 
 

Single Seat: R.S 
 Where: R is the Row Number 
  S is the Seat Number within the Row 
 
Range of Seats: Rs.Ss-Re.Se 
 Where: Rs is the Row Number of the start of the block 
  Ss is the Seat Number of the start of the block 
  Re is the Row Number of the end of the block 
  Se is the Seat Number of the end of the block 
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A typical Seats Specification is as follows: 
 1.4-1.17, 2.3-3.18, 4.1-6.20, 7.1, 7.20 
This sample specifies that Row 1 has seats 4 to 17, Row 2 and 3 have seats 
3 to 18, Rows 4 to 6 have seats 1 to 20 and Row 7 just has seats 1 and 20.  

6.1.5 Custom Layouts 
The “Import Template” button allows a Custom Seating Layout Template to be 
imported into a StageShow installation. This template must include a discrete 
HTML tag for each seat, which must have an HTML id specified as below: 
 

 id=”stageshow-boxoffice-layout-seat-R_S” 
 Where: R is the Row Number 
  S is the Seat Number within the Row 
 

StageShow adds additional class name, and Javascript event handlers to the 
HTML tag for each seat when it is imported. The “Physical” layout of the seats is 
not of significance to StageShow which determines the seat and row numbers for 
each seat, purely from the HTML tag id. Once imported, the “View Template” 
button can be used to display the associated Seating Template, and each seat 
can be selected to test that selection of each seat is possible. If required the 
“Export Template” facility can be used to download the current template, which 
could be the default template generated by StageShow, which can then be used 
as a starting point in the development of a custom template. 

6.1.6 Seat Decode Definition 
StageShow defines the location of each seat using a row number and a seat 
number within that row. For each Seating Plan these locations can be converted 
into alternative descriptions that are consistent with the those used in the venue. 
The conversion between row/seat numbers and the seat descriptions passed to 
the purchaser are defined by a “Seat Decode Definition” file. 
The Seat Decode Definition file is encoded as a “Tab Deliminated Text” file. Each 
line of the file defines the conversion of a number to a row and seat description. 
The entries on a line are separated by a “Tab” character. 
Sample Seat Decode Definition files, for alphabetical row descriptions, and for 
alphabetical seat descriptions are included in the StageShow distribution. 

Default: (None) 
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6.2 Shows Admin Page 

6.2.1 Show Name 
This is the name of the show. This can include any printable characters up to a 
maximum length of 80 characters. This Show Name is shown on the Box Office 
entry for the show, and on sales emails for the show using the default email 
template. 
To add a new show, click on the “Add New Show” button and a new show named 
“Unnamed Show N” will be added, where N is a number chosen to create a 
unique name. Once the new show has been added the name can be edited as 
required. 
To edit the name of a show, type the new name of the show in the edit text box 
and click the “Save Changes” button below. Note that duplicate names will be 
rejected. 
To delete a show or shows, select the shows to be deleted by selecting the 
associated checkbox(es), select Delete in the “Bulk Actions” drop down and click 
the Apply button. All selected shows will be deleted. 

Default: Unnamed Show N 

Maximum Number of Shows: Unlimited* (StageShow+), 1 (StageShow) 

6.2.2 Tickets Sold 
This entry shows the number of tickets sold for this show. Clicking on the entry 
transfers the user to a page listing the sales for the associated show (see section 
7.2 for details of the sales page).  
Note: This entry cannot be edited. 

6.2.3 State 
This shows the current “state” of a show, and can be Active or INACTIVE. An 
INACTIVE show is excluded from the Box Office output.  
The state of show(s) can be changed by ticking the associated checkbox, 
selecting Activate/Deactivate as appropriate in the “Bulk Actions” drop down and 
clicking the Apply button. The state of all selected shows will be “toggled”. 

Default: Active 

6.2.4 Options (from StageShow+) 
The options column provides a Show/Hide button which can be used to Display 
(Show) or Hide additional options for the associated show. When displayed the 
additional options are shown below the row with the Show Name. 

Default: Hidden 

6.2.5 Note (from StageShow+) 
This entry provides the facility to add a “note” entry for a particular show. This is 
included with the Box Office output immediately below the Show Name. 
The text can include HTML markup, so images, links etc. can be added here if 
required. 

Default: Empty 
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6.3 Price Plans Admin Page (from StageShow+) 
A “Price Plan” is one or more ticket types and associated prices that can be 
applied to a new performance when it is created. The number of price plans is 
unlimited*. 
To add a new Price Plan, click on the “Add New Price Plan” button and a new 
entry named “Unnamed Price Plan N” will be added with a single ticket type 
(TYPE1), where N is a number chosen to create a unique name. Once the new 
Price Plan has been added the Price Plan name, ticket Ref and Price can be 
edited as required. Note that duplicate Price Plan names will be rejected. 
Note: Once a performance has been created changing the price plan used to 
create it will not change the prices or ticket types of the performance. 

6.3.1 Name 
Each “Price Plan” is identified by its’ unique name. This can include any printable 
characters up to a maximum length of 20 characters.  
To edit the name of a Price Plan, type the new name in the text edit box and click 
the “Save Changes” button.  

Default: Unnamed Price Plan N 

6.3.2 Type 
This entry specifies the ticket type entry that will be created when a performance 
is created using this Price Plan. (see section 6.5.2 for details on Ticket Types). 

Default: TYPE1 

6.3.3 Price 
This entry specifies the ticket price when a performance is created using this 
Price Plan. (see section 6.5.3 for details on Prices). 

Default: 0.00 

6.3.4 Visibility 
This entry specifies the ticket price when a performance is created using this 
Price Plan. (see section 6.5.4 for details on Visibility). 

Default: Public 

6.3.5 No of Seats (from StageShow+) 
This entry specifies the No of Seats when a performance is created using this 
Price Plan. (see section 6.5.5 for details on No of Seats). 

Default: 1 
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6.4 Performances Admin Page 
This page is used to add performance dates to your show(s). 
To add a new Performance, select the “Price Plan” (from StageShow+) and click 
on the “Add New Performance” button and a new entry with default values will be 
added. Once the new Performance has been added the Performance Date & 
Time, Reference and Max Seats can be edited as required. 
Note: Performances do not appear in the Box Office output until Prices have been 
specified. 

6.4.1 Date & Time 
This is the date and time of the start of the performance. To change the entry, 
change the values and click the “Save Changes” button. 
The format of this entry is always YYYY-MM-DD hh:mm:ss 
Note that duplicate date and time entries will be rejected. 
 

Default: Current Local Time 

6.4.2 Reference 
Each performance is identified by its’ unique reference. This can include any 
printable characters up to a maximum length of 16 characters. The default entry 
includes a numeric value (N) chosen to create a unique name.  
To edit the reference, type the new reference in the text edit box and click the 
“Save Changes” button. Note that duplicate references will be rejected. 

Default: PERF N 

6.4.3 Max Seats 
The maximum number of tickets available can be limited if required. StageShow 
(and PayPal) will limit the number of tickets to this value. 
To change the entry, enter the new value and click the “Save Changes” button. 
Any negative number will be interpreted as “Unlimited” (shown as ∞). 

Default: Unlimited (∞)  

6.4.4 Tickets Sold 
This entry shows the number of tickets sold for this performance. Clicking on the 
entry transfers the user to a page listing the sales for the associated performance 
(see section 7.2 for details of the sales page).  
This entry cannot be edited. 

6.4.5 State 
This shows the current “state” of a performance, and can be Active or INACTIVE. 
An INACTIVE performance is excluded from the Box Office output.  
The state of performance (s) can be changed by ticking the associated checkbox, 
selecting Activate/Deactivate in the “Bulk Actions” drop down and clicking the 
Apply button. The state of all selected performances will be “toggled”. 

Default: Active 
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6.4.6 Options (from StageShow+) 
The options column provides a Show/Hide button which can be used to Display 
(Show) or Hide additional options for the associated performance. When 
displayed the additional options are shown below the row with the performance 
details. 

Default: Hidden 

6.4.7 Expires (from StageShow+) 
This entry shows the date & time that the booking window for the performance 
closes. This value is initialised to the performance Date & Time (see 6.4.1) less 
the Expire Limit (see 15.3.11) from the settings.  
To change the entry, change the values and click the “Save Changes” button. 
The format of this entry is always YYYY-MM-DD hh:mm:ss 

Default:  

6.4.8 Note Position (from StageShow+) 
This entry specifies the position of the performance Note (see 6.4.9). 

Default: Empty 

6.4.9 Note (from StageShow+) 
This entry provides the facility to add a “note” entry for a particular performance. 
This is included with the Box Office output and will be either immediately above or 
immediately below the performance entry depending on the “Note Position” 
setting (see 6.4.8). 
The text can include HTML, so images, links etc. can be added here if required. 

Default: Empty 
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6.5 Prices Admin Page 
This page lists the ticket types and their associated prices for each show. 
To add a new ticket type, click on the “Add New Price” button. A new entry will be 
added with ticket type set to TYPEN, where N is a number chosen to create a 
unique ticket ID.  
Once an entry has been added the Performance Date, Ticket Type and Price can 
be edited as required. Click on the “Save Changes” button to Save all the 
changes for a particular show. Note that duplicate Ticket Types will be rejected. 

6.5.1 Performance 
This drop down selection box allows the performance date to be specified. 

Default: First Performance 

6.5.2 Type 
The “Type” entry is used as a reference for the ticket type, and is also the 
description of the ticket used on the Box Office page, and within sale emails. 
This entry is a maximum of 10 characters long. 

Default: TYPEN 

6.5.3 Price 
The price of the ticket, in the currency specified in the StageShow PayPal 
Settings (see 15.1.8). 
This entry must be numeric, with or without a decimal point. The currency symbol 
should not be included here, but if required can be selected in the StageShow 
settings (see section 15.3.7).  

Default: 0.00 

6.5.4 Visibility (from StageShow+) 
This entry determines if this price will be visible on the Box Office page. When set 
to “Public” the price will be available on the Box Office page but if set to “Admin 
Only” it will only be available in the Add/Edit Sale admin pages. This allows the 
system administrator to create prices that are not generally available (for example 
discounted or free tickets). 

Default: Public 

6.5.5 No of Seats (from StageShow+) 
This entry determines the number of Seats that will be allocated for each sale of a 
ticket with the associated price. Typically this value is set to a value greater than 
1 for family tickets etc. 

Default: 1 
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7 Sales Log and Reports 
This section details StageShows’ sale recording and reporting functions. 

7.1 Recording Sales and IPN 
StageShow uses the shopping cart within PayPal as the interface between the 
prospective purchaser and the web site at the point at which the purchaser 
commits to the purchase. Subsequently PayPal uses its’ IPN facility to pass the 
details of the sale back to StageShow. These sale reports are saved to a 
database by StageShow and can be displayed or exported as required using the 
facilities described below. 
Note: Sale details will only be received by StageShow if the IPN settings in 
PayPal (see section 5.1.1) are correctly set up. 

7.2 Sales Admin Page 
The Sales Page gives an administrator access to the sales records recorded by 
StageShow, and enables new ones to be created manually. In addition 
StageShow+ displays details of any reservations and allows existing records to 
be edited. 

7.2.1 Sales List 
The Sales Page lists all sales in reverse chronological order. For each sale the 
sale details can be viewed by clicking the “Show” button, and concealed by 
clicking the “Hide” button. The sale details include the purchasers name, email 
and address, the transaction ID and a list of tickets purchased. 
Long lists of sales will be broken up into two of more “pages”, which can be 
viewed using the arrow buttons at the top or bottom of the list. 

7.2.2 Searching 
The search facility allows the Sales list to be searched for entries that match a 
specified text entry. Enter the text to be searched for in the edit box next to the 
“Search Sales” button, and click the button. A list of sales is displayed where the 
text entered matches all or part of the buyers name, PayPal Username or email 
address. 

7.2.3 Adding a Sale 
The “Add Sale” button opens an new page which allows a sale record to be 
added manually. All fields of the sale record are displayed and can be changed, 
and the ticket quantities for every performance can be specified. Click on “Save 
Changes” to save the sale record. 
When saved the admin screen will be updated to show an acknowledgement that 
the sale has been added. This includes a “View Ticket” button which opens a new 
browser window with a ticket identical to what would have been generated for an 
online sale. This can then be printed if required. 
Note: StageShow does not currently handle payment of any payment due when a 
sale is added using this “Add Sale” facility. 
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7.2.4 Editing a Sale 
The “Edit Sale” button (from StageShow+) opens an editor page which allows a 
sale record to be modified. All fields of the sales can be changed, and the ticket 
quantities for every performance can be specified. Click on “Save Changes” to 
save the updated sale record. 
When saved the admin screen will be updated to show an acknowledgement that 
the sale has been updated. This includes a “View Ticket” button which opens a 
new browser window with a ticket identical to what would have been generated 
for an online sale. This can then be printed if required. 
Note: StageShow does not currently handle payment of any refund or payment 
due when ticket quantities are changed using the sale editor. 

7.2.5 Deleting a Sale 
To delete a show or shows, select the sales to be deleted by selecting the 
associated checkbox(es), select Delete in the “Bulk Actions” drop down and click 
the Apply button. All selected shows will be deleted. 

7.2.6 Updating Reservations (StageShow+) 
To change one or more reservations to completed sales, select the reservations 
to be updated by selecting the associated checkbox(es), select Set Completed in 
the “Bulk Actions” drop down and click the Apply button. All selected reservations 
will be updated. 

7.2.7 View Ticket (StageShow+) 
The “View Ticket” button is shown when a new manual entry sale is added, or an 
existing sale is edited and saved. Clicking on this button opens a new window 
containing the sale ticket, which can then be printed or saved as required. 
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8 Tools 
This section details the facilities available on the StageShow-Tools page. 

8.1 Validate Sale 
The “Validate Sale” section of the tools page, provides the facility to verify a 
transaction ID for a particular performance and to record all such actions. When a 
valid transaction ID is entered and the “Validate” button is clicked the sale 
database is searched for a matching transaction ID for the specified performance, 
and, if a match is found, the matching sale record is shown.  
The control element “focus” is set to the Transaction ID when the page is loaded, 
and the “Enter” key performs the same action as clicking the enter key. As a 
result using a bar-code scanner to read the bar-code in a sale confirmation email 
when the StageShow-Tools page is active will automatically enter the scanned 
TransactionID into the form, and, provided the scanner terminates its’ output with 
a “Return”, will trigger the sale validation. 
Each valid validation is recorded, and displays a “Already Verified” warning if the 
sale has already been verified. This facility can be used to assist in detection of 
fraudulent repeat usage of the same transaction ID. As an additional option the 
identity or location of the PC used to verify the sale can be set on the 
StageShow-Settings page, and this is recorded when the sale is verified, and 
displayed, along with a date/time stamp, when a repeat verification is carried out. 
Note: Validate Sale functionality is only available to users with 
StageShow_Validate or StageShow_Admin capability. 
Note:. The selection of performance is only possible when the Tools menu is 
selected from the Wordpress admin menu, and when the page is reloaded after a 
verification attempt the performance will be set to the previously selected value. 

8.2 Export 
The export section provides the facility to export data from the Wordpress 
database that can subsequently be imported into other programs for further 
processing or analysis. 

8.2.1 Format 
The “Format” drop down box determines the file format of the exported file, as 
described below. 

8.2.1.1 Tab Delimited Text (TDT) Format 
Exported files are encoded as a “TAB Delimited Text” format file to your 
computer. In this format the file is in text format with columns of data separated 
by a TAB character. This format can be imported to many other programs, for 
example a spreadsheet for analysis, financial reporting etc. In all cases the first 
line of output gives identifies data field name that follows in that column. 

8.2.1.2 Open Financial Exchange (OFX) Format 
Exported file are encoded in accordance with the Open Financial Exchange 
Specification. This format is a standard using by many financial management and 
accounting application. 
Note: OFX format is only available with StageShow+ 
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8.2.2 Type 

8.2.2.1 Sales Summary 
This export request outputs sales records where each data line of the output file 
corresponds to a single sale for a single performance, with the total quantity of 
tickets purchased and a breakdown of the number of tickets of each type. 

8.2.2.2 Tickets 
This export request outputs sales records where each data line of the output file 
corresponds to a single sale for a single performance and a single ticket type. 

8.2.2.3 Settings Export 
This export request outputs the Show, Performance and Prices settings 
Note: Settings export is only available if the logged in user has StageShow_Setup 
capability (see section 9.6) 

8.2.3 Show 
This drop down selector allows the user to select export of either all shows or a 
specified show. 

8.2.4 Performance 
Where a show is specified by the Show drop down selector, the performance 
drop down selector allows the user to further refine the records exported by 
selecting a specified performance, or all performances. 

8.3 EMail Sale Test 
The “EMail Sale Test” section of the tools page, provides the facility to resend a 
sale confirmation Email, or to test the creation of them from an Email Template. 
The “Divert Email To” entry allows the user to specify an alternative Email 
address that will be used as the destination. If this is not specified the Email is 
sent to the original recipient(s). 
The “View Ticket” button (from StageShow+) opens a new window containing the 
sale ticket for the selected sale, which can then be printed or saved as required. 
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9 Capabilities 
9.1 Overview 
When activated StageShow adds four custom “Capabilities” to the Wordpress 
site, and enables them all for the Administered role. These Capabilities can be 
used to control access to StageShow admin pages by users. 
The capabilities for a particular user can be edited from the Wordpress Users 
admin menu page, or by installing and using the “User Role Editor” plugin for 
wordpress. 

9.2 StageShow_Reservations 
Enabling this category makes the “Reservations” facility available to a user, when 
enabled in the settings (see ). 

9.3 StageShow_Validate 
Enabling this category adds access to the Validate Sale and Export Sales 
sections of the StageShow-Tools page for a user. 

9.4 StageShow_Sales 
Enabling this category adds access to the StageShow-Sales page, with the 
capability to add a sales manually for a user. 

9.5 StageShow_Admin 
Enabling this category adds access to all StageShow admin pages except for the 
StageShow-Settings page for a user. 

9.6 StageShow_Setup 
Enabling this category adds access to the StageShow-Settings page for a user. 

9.7 StageShow_ViewSettings 
Enabling this category adds read-only access to the StageShow-Settings page 
for a user. 
 
 
 

 
 



 

StageShow Help  Updated 23/04/2014 Page 20 
 

10 Advanced Customisations 
10.1 Email Templates  
StageShow generates emails based on template files. Default template files are 
included in StageShow distributions, and are copied to a subfolder of the 
wordpress uploads folder when the plugin is activated or updated. Working 
copies of the email templates are located in the following folder: 

{Your-site}/wp-content/uploads/{StageShow--folder}/emails 
Emails can be customised as required by making a copy of the default template 
with a new name and then editing this new template as required. This revised 
template can then be selected on the StageShow settings page. 
Note: The default templates can be edited, but these edits will be lost if the plugin 
is updated. 

10.2 Box Office Output 
The format of the Box Office Output is controlled by CSS style classes. By default 
these styles are defined in the stageshow.css file, and can be determined by 
using the “Inspect Element” option on a suitable browser. 
The format of the Box Office output can be customised by modification of these 
styles. These customisations can be implemented by adding entries to the style 
sheets in the site theme. Where a “standard” wordpress theme, or a theme 
supplied by a third party is in use, it is recommended that a child theme of the 
original theme is used, and that any CSS customisations are applied to this. 
Note: Any changes made to stageshow.css will be overwritten if the plugin is 
updated. 

10.3 Date & Time Format 
By default, the format of date and time output of both the Box Office output, and 
the shopping trolley output is determined by the Wordpress “Date Format” and 
“Time Format” settings, set on the Wordpress General Settings page. These 
settings can be overridden for the StageShow output by defining the value of 
STAGESHOW_DATETIME_BOXOFFICE_FORMAT in the wp_config.php file. A 
typical definition is as follows: 

define('STAGESHOW_DATETIME_BOXOFFICE_FORMAT', 'd-m-Y H:i'); 

10.4 Checkout Header Image 
The image used for the PayPal Checkout page can be customised to use a user 
defined image. The default image is included in StageShow distributions, and is  
copied to the following folder when the plugin is activated or updated: 

{Your-site}/wp-content/uploads/{StageShow--folder}/images 
To customise the Checkout Header, create a new image (750px by 90px) in gif, 
png or jpg format, transfer it to the above folder and then select the new image on 
the StageShow-Settings page.  
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10.5 Email Logo Image 
The logo image which may be included in Emails can be customised to use a 
user defined image. The default image is included in StageShow distributions, 
and is  copied to the following folder when the plugin is activated or updated: 

{Your-site}/wp-content/uploads/{StageShow--folder}/images 
To customise the Logo, create a new image in gif, png or jpg format, transfer it to 
the above folder and then select the new image on the StageShow-Settings 
page. The default image is 180px by 34px but the customised image can be any 
size the user desires. 
Note: The Email Logo is only available for StageShow+ with an HTML email 
template. 

10.6 Barcode Size (StageShow+) 
The barcodes generated by StageShow conform to the Code39 Barcode 
specification. This specifies two widths for the component parts of the barcode, a 
“Thin” width and a “Thick” width. These values are determined by constants 
defined by StageShow. There are also constants for the height of the barcode, 
and the size of the associated text. Theses constants are as follows: 
 

Constant Default Value 

BARCODE_THINWIDTH 1 

BARCODE_THICKWIDTH 3 

BARCODE_HEIGHT 45 

BARCODE_FONTSIZE 5 

 
These settings can be overridden by defining the value of in the wp_config.php 
file for the site. A typical definition is as follows: 

define(' BARCODE_THINWIDTH ', 2); 
 

Note: For Compliance with the Code39 specification the ratio between 
BARCODE_THINWIDTH and BARCODE_THICKWIDTH must be 
between 1:2 and 1:3. 
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11 Translation 
11.1 Overview 
StageShow supports the mechanism built into Wordpress for localisation of its 
text output. This mechanism uses a POT file (Portable Object Template), created 
by the plugin developer, to define the English language messages that can be 
generated by the plugin. This file is then used, by a translator, to create a PO file 
(Portable Object) which defines both the English language message and its’ 
translation in the target language. The PO file can then, if required, be bundled in 
with the plugin distribution to add the translation to the standard distribution. 
Wordpress uses the value of WP_LANG (usually defined in wp_config.php) to 
determine the language for translations, and this must be set for translation of the 
StageShow plugin to work. If WP_LANG is not defined Wordpress defaults to 
en_US. 

11.2 Location of Language Files 
StageShow will check for language files in two directories. Firstly the Wordpress 
system language directory is checked. This directly is defined by the 
WP_LAND_DIR system constant. If a StageShow translation file is not located 
there, the ‘lang’ directory in the StageShow plugin folder is checked. This folder 
also contains all language files shipped with StageShow, so any custom 
language files stored here will be lost when StageShow is updated. 

11.3 Tools 
A number of tools exist to assist translators with the process of creating a PO file 
from a POT file. The plugin author recommends POEDIT, and open source cross-
platform tool which can be downloaded from http://www.poedit.net/. 

11.4 Translating With Poedit  
• Download a local copy of the stageshow.pot file from the lang sub-folder 

of the StageShow plugin on your website. 

• Download, install and run POEDIT. 

• Click the “Open” button to display the open file dialogue. Select the “All 
Files” file filter, browse to the stageshow.pot file and click open. 

• The main window shows a list of all source text entries, and their 
translations if one exits. When an entry is selected in the main window, 
the source text is shown in the window below the list, and the editable 
translation is shown in the window below that.  

• Items in the list may specify entries for singular and plural forms of the 
message. In this case the middle and bottom windows show multiple 
entries for the source text and translations. 

• Work through the source text list, adding translations in the bottom 
window as required. A summary of the total number of source text entries, 
and the number remaining un-translated is shown at the bottom of the 
window.  
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• To save your translations, click File → Preferences  and on the Editor 
tab  confirm that the Automatically compile .mo file on save box is checked 
(select this option and click OK if it is not). Then go to File → Save as…  
and save your translations as a PO file. The file name should be 
stageshow-ls_CC.po where ls is the language specified for the target 
language and CC is the country code. Complete lists of language codes 
can be found at http://en.wikipedia.org/wiki/List_of_ISO_639-1_codes and 
country codes at http://en.wikipedia.org/wiki/ISO_3166-1_alpha-2. 

• Upload the stageshow-ls_CC.mo file you have created to the lang sub-
folder of the StageShow plugin on your website. 
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12 Testing StageShow  
This section details how to test that a new installation works correctly. The same 
general procedures, modified where required, can be used to test an existing 
setup. Note that to fully test your StageShow installation, you will need to make 
an actual transaction. This transaction can subsequently be refunded, but PayPal 
fees may still be payable (see PayPal terms and conditions for details on fees 
and refunds). 

12.1 Setup Tickets 
Login to your PayPal account and set up API Access (see 5.1.2) and enable IPN 
(see 5.1.3) as required, if you have not already done so 
Install and activate the StageShow plugin, and add the PayPal Settings (see 
15.1), if you have not already done so. 
You can create a sample setup by clicking the “Create Sample” button on the 
StageShow Overview admin page. This sample includes at least one show, with 
performance dates, prices and a few sample sales. Alternatively use the Show, 
Performance and Prices admin pages to set up a sample setup. 
Create a new Page or Post (which can be saved as Draft) using the Wordpress 
admin pages and add the [sshow-boxoffice] shortcode to it. Now view the page or 
post you have just created. The page/post should include the StageShow Box 
Office output with a number of performance and ticket type options, each of which 
has a drop-down box to select a quantity and an “Add” button to add the quantity 
to the shopping cart. 

12.2 Summary Email (StageShow+) 
StageShow can be configured to send a email with a summary of ticket sales for 
all performances whenever a new sale is recorded. To test this enter a email 
address to the “Sale Summary Report Email” entry (see section 15.4.1) in the 
setting page before making a test sale. 

12.3 Making a Sale 
On the Box Office page you created above, select a number of tickets for one of 
the shows, and click the “Add” button. The page will refresh with a “Shopping 
Trolley” section including tickets for the performance you have just selected. Go 
back to the Box Office page and add some more tickets. Again the page will 
refresh with the new tickets added. Once you have sufficient tickets for testing 
purposes select “Check Out” and complete the purchase using a PayPal account 
or Credit Card. (Note that you will not be able to use the PayPal account used by 
StageShow to make the purchase). 
Once the purchase has been completed check that you receive an Email from 
PayPal with the details of the sale and the purchaser. If required you can then 
refund the sale by logging in to your PayPal account, navigating to the details for 
the transaction and clicking on the “Issue a Refund” button. 
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12.4 Sales Log 
If correctly setup StageShow will record all sales in its’ sales log. Check this by 
looking at the sales log once a test sale (see section 12.2) has been successfully 
completed. Sales are listed in reverse chronological order, and the details of each 
sale can be seen by clicking the “Show” button next to it. Note that sales can take 
a few minutes to be shown due to processing time delays on the PayPal servers. 

12.5 StageShow Sale Emails 
Once StageShow has recorded a sale, a confirmation email will be sent to the 
purchaser and (optionally, see section 15.3.6) to the StageShow admin email 
address. A summary email (see section 12.2) can also be sent. The content of 
these email is determined from the sale details and the email templates selected 
(see 15.3.2 and 15.4.2). 
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13 Fault Finding 
Even with the correct settings, there is the possibility of problems with StageShow 
caused by server configuration. This section is provided to give guidance on 
resolving any such issues. 

13.1 Error Saving PayPal Settings 
When API Access (see 5.1.2) settings are saved, StageShow makes a test 
transaction with the PayPal server to confirm that the values entered are correct. 
Any error in the entries will result in an error, which is reported when the settings 
are saved. The error code is that which is reported by the PayPal server and 
should give an indication of the type of error experienced.  

13.2 Sales missing in Sales Log 
If sales are being reported by PayPal but are missing from the Sales Log, there is 
a problem with IPN (see 5.1.3). 
 
Firstly check that PayPal is sending IPN notifications. Log in to your PayPal 
account and go to History | IPN History. Change the date filter to include the sale 
that you want to check and click "Search". You should see an entry for the sale in 
the list. If you do not see any IPN requests then the problem lies in your PayPal 
IPN settings. 
 
Now click on a message ID entry in the list to see the details of the IPN request, 
and check the "HTTP response code". This code indicates the result when 
PayPal attempts to access the IPN Notification URL on your website, with 200 
indicating a successful request, and anything else indicates an error. (A complete 
list of HTTP response codes can be found on the internet at 
http://www.w3.org/Protocols/HTTP/HTRESP.html). As an additional test the IPN 
Notification URL, which must be public ally accessible, can be opened in your 
browser by entering the following URL: 

{Your-site}/wp-content/plugins/{StageShow--
folder}/StageShow_NotifyURL.php 
The response in the browser should be the single word "INVALID". 
 
PayPal will continue to attempt to send IPNs at intervals for sales that have not 
been recorded until a timeout determined by the PayPal server (possibly 28 days) 
is exceeded. This means that any sales recorded by PayPal may still be logged 
by StageShow even if there are IPN issues when the sale is made (provided IPN 
was enabled). 
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14 StageShow “In Action” 
This section describes how StageShow might be used in a number of different 
sales scenarios. 

14.1 Online sales – Tickets Collected (Pre-selected) 
The website is used to sell tickets, which are then held for collection at the door 
or box-office. 
The email generated by PayPal for each sale is used to extract the purchasers’ 
name and the tickets requested. Then, typically, paper copies of these tickets 
would be grouped together for collection by the purchaser later. 
This scenario will work without IPN enabled, but sales reports will only be 
available if IPN is enabled. 

14.2 Online sales – Tickets posted 
The website is used to sell tickets, which are then sent to the purchaser by post.  
This is identical to the “Online sales – Tickets Collected” scenario except that 
tickets are mailed out on receipt of a sales email. 

14.3 Online sales – Tickets collected at Performance 
The website is used to sell tickets, which are then collected by the purchaser 
when they arrive for the performance. 
The sale “Transaction Id” is used as the reference for the transaction, and the 
Validate Sale option on the Tools menu is used to verify the sale. This displays 
the tickets purchased, and logs that the tickets have been collected. Paper tickets 
corresponding to the sale are then given to the purchaser, 
This scenario requires that IPN is enabled. 

14.4 Online sales – E-Tickets  
The website is used to sell tickets, with the confirmation Email generated by 
StageShow being used as an E-Ticket. 
As for the “Online sales – Tickets collected at Performance” scenario, the sale 
“Transaction Id” is used as the reference for the transaction, and the Validate 
Sale option on the Tools menu is used to verify the tickets at the auditorium door. 
This scenario requires that IPN is enabled. 

14.5 “Offline” Sales Verification  
If it is not possible to have a online terminal at the venue, then the “Offline 
Validator” can be downloaded prior to the performance once ticket sales have 
closed, and used in place of online sale validation. 

14.6 Transaction ID Barcodes 
StageShow+ provides the facility to add a barcode of the Transaction ID to the 
sale confirmation email, and this can be scanned using a barcode reader to 
authenticate a sale (see 8.1).  
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15 Settings 
This section details the entries on the StageShow-Settings admin page. 

15.1 PayPal Settings 
This section details settings used by StageShow to interface to the PayPal 
server.  

15.1.1 Environment  
The PayPal environment to use for StageShow. PayPal has a test environment 
used by developers called the “Sandbox”. For normal usage this option should be 
set to “Live”. 

Default: Live 

15.1.2 Merchant ID 
The Merchant account ID from the Business details in the PayPal account.  

Default: {Blank} 

15.1.3 API User 
The API username from the PayPal API Access settings (see 3.2).  

Default: {Blank} 

15.1.4 API Password 
The API Password from the PayPal API Access settings (see 3.2). 

Default: {Blank} 

15.1.5 API Signature 
The password from the PayPal API Access settings (see 3.2). 

Default: {Blank} 

15.1.6 Account Email 
The primary email for the PayPal account, as shown on the PayPal “My Business 
Details” page. 

Default: {Blank} 

15.1.7 Checkout Timeout 
The time interval, in minutes, before a “Pending Sale” that remains unpaid is 
discarded. A pending sale is created when a buyer clicks on the Checkout button 
within the “Shopping Trolley” section. This action launches the PayPal checkout 
window for the buyer to complete the purchase.  

Default: 60 minutes 

15.1.8 Currency 
The currency selected for PayPal transactions. 

Default: GBP 
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15.1.9 PayPal Header Image File 
The Header image which PayPal will use as the header for shopping cart and 
checkout pages. The image size should be 750 x 90 pixels. 

Default: /StageShowHeader.gif 

15.1.10 EMail Logo Image URL 
The URL of a Logo image which can be added to the top of all emails sent by 
StageShow. The image size should be 180 x 34 pixels. 

Default: StageShowLogo.jpg 

15.1.11 Checkout Complete URL 
The URL of a page that PayPal will redirect to after a successfully completed 
purchase. The “Auto Return for Website Payments” option in the PayPal “Website 
Preferences” settings determines the detail of how this works; if clear the buyer 
will be offered a link to return to the sellers website, if set the return will occur 
automatically but only if the “PayPal Account Optional for new users” option is not 
set. 

Default: {Empty} 

15.1.12 Checkout Cancelled URL 
The URL of a page that PayPal will redirect to after a PayPal checkout is 
cancelled. 

Default: {Empty} 
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15.2 Reservations (from StageShow+) 
This section details settings used by StageShow+ to determine if reservations are 
enabled and the capture of user information when a reservation is made. 
Note: The options offered are the “standard” Wordpress user fields from the user 
profile, and any additional fields added by plugins extending the user profile. 
These plugins must be installed and activated, and the user profile for the current 
user (probably admin) must be updated and saved, for any extra fields to appear. 
The value of these fields for the logged in user are included in brackets to assist 
in identifying the correct field. 
If fields created by plugins are used in the settings, and the plugin is 
subsequently removed the settings must be updated to reassign these fields.  

15.2.1 Enable Reservations 
This checkbox controls whether the option to make a reservation is offered to a 
logged in user. When ticked reservations will be enabled. 
Note: Reservations will only be offered to a user with a “Role” that has the 
StageShow_Reservations “Capability” enabled. 

Default: Disabled 

15.2.2 Address 1 
Defines the user profile field that maps to the first element in the users address.  

15.2.3 Address 2   
Defines the user profile that maps to the second element in the users address. If 
defined, this entry is merged with the preceding address element. 

15.2.4 Address 3   
Defines the user profile that maps to the third element in the users address. If 
defined, this entry is merged with the preceding address element. 

15.2.5 City   
Defines the user profile that maps to the city entry of the users address.  

15.2.6 County   
Defines the user profile that maps to the county entry of the users address.  

15.2.7 Postcode   
Defines the user profile that maps to the postcode entry of the users address.  

15.2.8 Country 
Defines the user profile that maps to the country entry of the users address.  

15.2.9 Phone 
Defines the user profile that maps to the phone entry of the users address.  
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15.3 General Settings 

15.3.1 Organisation ID 
The name of the theatre or other organisation selling tickets.  
StageShow will substitute any [organisation] entries in the selected email 
template with this value, and will use the value as the “Friendly Name” for the 
“from” email address in any emails it sends. 

Default: Site Title 

15.3.2 Sale EMail Template 
This entry determines the template file used to create sales emails.  
Note: Only StageShow+ supports emails in HTML format. 

Default: Site Title + “Sales” 

15.3.3 Reservation EMail Template (from StageShow+)  
This entry determines the template file used to create reservations emails.  

Default: Site Title + “Sales” 

15.3.4 StageShow Sales EMail Name (from StageShow+)  
This entry, if defined, will replace the Organisation ID (see section 15.3.1) as the 
“Friendly Name” for the “from” email address in any emails StageShow creates. 

Default: Site Title + “Sales” 

15.3.5 StageShow Sales EMail 
The EMail address used as the “from” address for emails sent by StageShow. 
This email is also used as the destination for any admin emails sent by 
StageShow. 

Default: Site Administrator E-mail Address 

15.3.6 Bcc EMails to WP Admin 
If this option is selected, StageShow will send a “Blind Copy” (bcc) of any emails 
it sends to the Sales EMail (see section 15.3.2)  

Default: Selected 

15.3.7 Currency Symbol 
If this option is selected, StageShow will include the currency symbol associated 
with the currency selected in the PayPal Settings (see section 15.1.8) with any 
prices displayed within the box office output. 

Default: NOT Selected 
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15.3.8 Box Office Below Trolley 
In normal operation the Box-Office output generated by StageShow replaces a 
shortcode in a Page (or Post), and its’ position is determined by the location of 
the shortcode in the Page. The Shopping Trolley is always positioned (by CSS) at 
the top of the page. Selecting this option relocates the Box-Office output when a 
shopping trolley is active, so it is immediately below the Shopping Trolley. 

Default: NOT Selected 

15.3.9 Items per Page 
This option sets the maximum number of entries in that will be displayed on 
admin page lists. If the number of pages exceeds this value, StageShow will split 
the entries across two or more pages. 

Default: 20 

15.3.10 Max Ticket Qty 
This option sets the maximum number of tickets of each type that will be available 
to the prospective purchaser in the quantity drop down box within the box office 
output. Note that the user can still select the add button again to increase the 
number of tickets purchased. In all cases the maximum number of tickets 
available is always limited by the Performances configuration (see section 6.4.3). 

Default: 4 

15.3.11 Performance Expires Limit (from StageShow+)  
StageShow removes each performance from the Box Office output a set time 
interval before the performance start time. This option sets the default time 
interval and can be specified in hours, minutes or seconds. 
Note: This time interval is ignored for a particular performance if its’ Expires time  
(see 6.4.7) has been changed. 

Default:  Zero 

15.3.12 Terminal Location (from StageShow+) 
This option is used to specify the physical computer being used to access 
StageShow, and is stored as a cookie so can be unique for each computer used. 
This location is used during sale validation. 

Default: Unknown 

15.3.13 Sale Transaction ID (from StageShow+) 
This setting specifies the Transaction ID as shown on the StageShow+ sale 
invoice, used for sale verification purposes. This must be specified for auto-
update of the StageShow+ plugin to operate. 

Default: {Blank} 

15.3.14 Sale Txn EMail Address (from StageShow+) 
This setting specifies the purchasers Email address as shown on the 
StageShow+ sale invoice, used for sale verification purposes. This must be 
specified for auto-update of the StageShow+ plugin to operate. 

Default: {Blank} 
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15.4 Advanced Settings 

15.4.1 Sale Summary Report EMail (from StageShow+) 
This entry, if defined, specifies an email address that a Sale Summary email will 
be sent to on each new sale. The file specified by the Summary Email Template 
entry (see 15.4.2) is used as an EMail template to generate this EMail. This 
template can be modified if required, but any changes may be overwritten when 
the plugin is updated. 
If this entry is left blank, no summary email is generated.  

Default: {Blank} 

15.4.2 Summary EMail Template (from StageShow+) 
This entry determines the template file used to create sales summary emails. 

Default: StageShowplus_SummaryEMail.php 

15.4.3 Allocated Seating (StageShowGold) 
Selecting this option adds the options to create Seating Plans and to optionally 
allocate a seating plan to any performance. When allocated seating is enabled, 
the ticket selection process includes additional steps to select a performance, 
seats and ticket types.  

15.4.4 Checkout Note Position 
This entry determines the position of the Checkout Note (see 15.4.4). 

Default: {Blank} 

15.4.5 Checkout Note 
This entry defines a text “note” entry to be included with the “Shopping Trolley” 
output. This can be in one of a number of positions within the output, specified by 
the Checkout Note Position (see 15.4.4). 
The text can include HTML markup, so images, links etc. can be added here if 
required. 

Default: {Blank} 

15.4.6 Seats Available  
Selecting this option adds a line to the Box-Office for each performance with the 
number of unsold seats. 

Default: NOT Selected 

15.4.7 Booking Fee (from StageShow+) 
This option sets a Booking Fee for each sale. When this entry is set, an additional 
line for the booking fee will automatically be added to the Shopping Trolley when 
the first ticket is added. 

Default: {Blank} 
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15.4.8 Custom Stylesheet 
Specifies the name of the custom stylesheet (if any) to load after the standard 
StageShow stylesheet. StageShow searches for stylesheets in the following 
folder: 

{Your-site}/wp-content/uploads/{StageShow--folder}/css 

15.4.9 Log Files Folder Path (from StageShow+) 
The path used for any log files created by StageShow. The path is relative to the 
root folder of the site. Note that the path should be chosen so that any log files 
generated are not published on the internet. 

Default: ../logs 

15.4.10 Website Link (from StageShow+) 
Selecting this option removes the “Driven by StageShow**” entry at the bottom of 
the StageShow Box-Office output. 

Default: {Blank} 


